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CHAPTER – 1 

INTRODUCTION 

ALZHEIMER DISEASE 

Alzheimer disease (AD) is a progressive neurodegenerative disease 

results in death of  brain cells.It causes memory loss and cognitive decline.The 

symptoms are mild at first and becomes more severe overtime.The disease was 

named after the German Physician Aloes Alzheimer in 1906. According to 

National Institute on Aging Alzheimer disease is the sixth major cause of death 

in U.S.Old aged people are more prone to AD.
[1] 

 

Fig:1 Progression of Alzheimer Disease.
[5] 

The main features of AD is the 

 Presence of Plaques and Tangles in brain 

 Loss of connections between the nerve cells in brain.  

DEMENTIA 

Dementia is a general term for the symptoms affecting 

memory,communication and thinking.   Alzheimer disease is the most common 

form of dementia.Types of dementia are 

 Alzheimer disease 

 Vascular dementia 

 Dementia with lewy bodies 

 Temporal lobar dementia.
[2]
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CAUSES OF ALZHEIMER DISEASE 

The  brain has 100 million nerve cells.Each nerve cell connects with one 

another to form communication networks.Each group of nerve cells have 

specific function.some neurons are involved in thinking,learning and 

memory.Some neurons are involved in hearing and smelling.They process and 

store the information and communicate with other cells.In diseased condition 

brain cells fails to function normally,which disrupts the neurons and triggers a 

series of toxic events.Neurons get damaged and loses connection to each other 

and eventually die.
[3] 

AD are focussed on two types of proteins PLAQUES AND TANGLES. 

They leads to destruction of nerve cells in the cerebral cortex of brain.  

PLAQUES 

Beta amyloid is a fragment of larger protein.When these fragments 

closer together they appear to have toxic effects on neurons and disrupts the 

cell to cell communication.These clusters form larger protein called amyloid 

plaques.These biochemical events leads to neuronal death with subsequent 

production of free radicals.
[4] 

These beta amyloid protein is formed by the 

cleavage of the amyloid precursor protein (APP).These event is mediated by 

the enzyme β-secretase. 

 

Fig:2  Accumulation of plaques in neurons
[6] 
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TANGLES 

Tau proteins play a part in neuronal internal support and transport 

system to carry nutrients and other essential materials. AD tau proteins change 

their shape and organize themselves to a new structure called neurofibrillary 

tangles.These tangles disrupt transport system and are toxic to nerve cells.
[4] 

 

Fig:3  Accumulation of tangles in neurons
[7] 

NEUROTRANSMITTER IN ALZHEIMER DISEASE 

Both Cholinergic and Glutamatergic transmission involved in the 

etiology of Alzheimer disease. 

The loss of memory is considered to be the result of shortage of 

neurotransmitter Acetylcholine. It is possible to increase the level of this 

transmitter by inhibiting the activity of enzyme acetylcholinesterase which 

splits or breakdown the transmitter substance. 

Glutamatergic hypothesis links the cognitive decline in patients with 

Alzheimer to neuronal damage resulting from overactivation of  N-methyl-D-

aspartate (NMDA receptors) by glutamate. Low  level activation of NMDA 

receptors which are pivotal in learning and memory which may result from 

deficiencies in glutamate reuptake.
[8] 
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TYPES OF ALZHEIMER DISEASE
[9] 

 Early onset AD (Occurs between 40-60 years of age) 

 Late onset of AD (Occurs above the age of 65) 

 Familial AD (Rare AD caused by mutations in genes) 

ALZHEIMER DISEASE – A GLOBAL BURDEN 

The old aged people are more prone to AD.Alzheimer affects about 36.5 

millions of the world population.An estimated 0.7%of the gobal population has 

dementia cases.The total number of persons affecting from AD has doubled 

from 1990 to 2019.Japan has the highest prevalence (3,097 cases per 100,000) f 

ollowed by Italy,Slovenia,Monaco,Greece and Germany.The prevalence is 

higher in high income countries like Western Europe compared to Asia and 

Africa.Women are more likely to be affected than men.More than   6 million 

Americans are living with AD.
[10,11,16] 

In  United States,Alzheimer and dementia deaths have increased 16% 

during COVID -19 pandemic. 

 

Fig:4  Worldwide prevalence of Alzheimer disease
[12]

. 
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FACTORS RESPONSIBLE FOR ALZHEIMER DISEASE 

Alzheimer disease caused by a combination of genetic,lifestyle and 

environmental factors that affect the brain overtime.The factors responsible for 

AD are as follows
[14] 

 Aging 

 Family history 

 Genetics 

 Cardiovascular problems 

 Type 2 Diabetes 

 Poor diet and excercising habit 

 Head injury 

 Lack of mental ability 

 Smoking 

 Drinking 

 

Fig:5  Factors the cause of AD.
[13] 
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SYMPTOMS OF ALZHEIMER DISEASE 

The symptoms progresses slowly over several years.The symptoms 

differ from individual to individual. The other conditions like stroke, delirium 

are also responsible for the symptoms to worsen.The mild and moderate 

symptoms are
[17] 

Early symptoms are 

 Trouble in thinking 

 Forget recent conversation,name of places 

 Hard to make decision 

Middle stage symptoms are 

 Confusion and disorientation 

 Impulsive behaviour 

 Mood swings 

Later stage symptoms are 

 Hallucinations and delusions 

 Weight loss 

 Unintentional passing of urine 

 Gradual loss of speech 

 Significant problem with short and long term memory.  

DIAGNOSIS OF ALZHEIMER DISEASE 

Alzheimer disease is usually diagnosed bsed on the persons medical 

history,history from relatives and behavioural observations.The presence of 

characteristic neurological and neurophsychological features and absence of 

alternative conditions supports the diagnosis
[18] 
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Recent advances to diagnose the Alzheimer disease are 

 Blood studies 

 Brain MRI /CT scan 

 SPECT (Single Positron Emission Computed Tomography) 

 PET (Positron Emission Tomography) 

 Lumbar puncture 

 Genotyping 

 Electroencephalography 

MANAGEMENT OF ALZHEIMER DISEASE 

 To maintain patients brain function as far as possible 

 To treat psychiatric and behavioural sequale 

 To focus on emotional and supportive care of concerned patient  

 To reduce morbidity and mortality as far as possible 

 To improve quality of life 

ORAL ANTI-ALZHEIMER DRUGS 

The deficiency in cholinergic neurotransmission of AD leads to 

cholinesterase inhibitor as first line symotoms of disease.
[19] 

The clinical 

benefits of these agents include improvements,stabilised or less than expected 

decline in function,cognition and behaviour.Several new Alzheimer drugs have 

been approved in recent years but the exact cause of AD is unknown 

It is important to understand the safety and efficacy of these medication 

for proper use therapies for alzheimer disease. 
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There are different class of anti alzheimer drugs are available
[20] 

S. 

No 
Drug class Examples of drug Adverse effect 

1 Cholinesterase 

Inhibitor 

Donepezil, Rivastigmine 

Galantamine, Tacrine 

Muscle cramps, 

bradycardia, 

Hepatotoxicity 

2 NMDA antagonist Memantine Cataract, Agitation 

3 PPAR Gamma 

antagonist 

Pioglitazone Nausea, vomiting 

4 Antioxidants Gingo biloba,             Vit 

E, Melatonin 

Haemorrhage 

5 Gamma secretase 

inhibitor 

Semagacest GIT irritation 

6 Statins Simvastatin, pravastatin Liver damage 

7 Others Heavy metals, Estrogen,  

Anti-inflammatory drugs 

Stomach ulcers, 

Dizziness, Headache 

MEDICINAL HERBS TO TREAT ALZHEIMER 

Herbal medicines have their origins in ancient cultures, including those 

of the Egyptian, Indians and Chinese. It involves the use of medicinal plants to 

treat AD and enhances general health and well beings. In fact, many 

pharmaceutical drugs are based on the synthesized adaptations of naturally 

occurring compounds found in plants.
[21] 

In recent years, interest in herbal medicine has increased, leading to a 

greater scientific interest in the medicinal use of plants in treating disease and 

improving health, often without any significant side effects. Herbal medicines 

and natural products are the oldest remedies known to mankind. Medicinal 

plants have been used by all cultures throughout the history. In present 

scenario, the demand for herbal products is growing, exponentially throughout 

the world. 

In human body, the nervous system coordinates and regulates the 

various voluntary and involuntary activities of the body. the central nervous 
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system and the autonomic nervous system are interlinked and some drugs affect 

the CNS producing reactions associated with the autonomic system . 

Drugs involved with the CNS may have general stimulatory or 

depressant action with anticonvulsant and psychopharmacological activities. 

Memory deficit is a major global health problem. Current therapies are 

inadequate and have numerous adverse effects. There is an urgent need for 

possible alternative treatments for AD and memory deficit. Various medicinal 

plants are prescribed to enhance the memory. We have reviewed the literature 

on medicinal plants used in the treatment of AD and memory deficit . 

Several medicinal plants have been used for decades in different cultures 

to improve memory such as Valeriana officinalis,Punica granatum l., Salvia 

officinalis, Myristica fragrans Bacopa monnieri linn, Centella asiatica linn 

and Evolvulus alsinoides linn. Elufioye et al. (2012) reported some plants used 

as anti-aging and memory enhancing activities in Sagamu, Nigeria that 

are Bacopa floribunda, Angraecum eichlerianum, Parquet inanigrescens, 

Cleome gynandra, Dalbergia lacteal, Capsicum fructescens, Aframomum 

melegueta, Digitaria debilis, Musa sapientum, Bryophyllum pinnatum, Abrus 

precatorius, Ficus exasperate, Dioscorea mangenotiana, Jatropha curcas, 

Spondia smombin, Capsicum frutescens, Cola acuminate, Mirabilis jalapa, 

Elaies guineensis, canna indica, Ipomoea mauritania, Bambusa vulgaris, 

Cordia millenii, Piper guineense, Dioclea sarmentosa, Cucumeropsis 

mannii, Eleusine indica, Ocimum basilicum, Khaya ivorensis, Carpolobia 

alba, Carapa procera, Entandrophragma utile, Xylopiaae thiopica, Garcinia 

kola, Theobroma cacao, Milicia excels, Blighia sapida, Baphia 

nitida, Peperomia pellucid, Vernonia amygdalina. 

These herbal plants shows various potential activities like free radical 

scavenging activities, Anti-amyloidogenic,Anticholinesterse, Hypolipidemic, 

Antioxidant and Anti inflammatory activities.  

The major steps in the discovery of bioactive compounds from plants are 

solvent extraction, bioassays, isolation, characterization, toxicological 
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evaluation, preclinical and clinical investigation of isolated bioactive 

compounds.
[22] 

TERPENOIDS AS ANTI-ALZHEIMER AGENTS 

Ginsenosides from Panax ginseng 

Ginsenosides are a series of derivatives of the dammarane-type 

triterpenes with some sugar moieties attached, which are active components in 

ginseng.Among the diverse ginsenoside Rg1, Rg2,Rg3 reduces the β-amyloid 

protein levels by promoting  Aβ degradation and by enhancing  reprilysis gene 

expression.
[44] 

Ginkgolides and Bilobalide from Ginkgo biloba.L 

Ginkgolides are cyclic diterpenes of labolane type commonly isolated 

from G.biloba.Extract of G.biloba leaves which contains 24% flavanoid 

glycosides, 6% terpenes, 5-10% organic acids has been extensively evaluated 

for its neuroprotective effects.Ginkgolides revrse the Aβ induced reduction of 

acetylcholinesterase release from hippocampal brain.  

Cannabinoids from Cannabis sativa`L 

Cannabinoids are the aromatic compounds containing a monoterpene 

isolated from C.sativa. This plant contains about 60 cannabinoids,, and one of 

potential anti-alzheimer agent is Tetrahydro cannabinol (THC).THC 

competitively inhibits AchE and increases the availability of Ach helps in 

memory. 

Other terpenoids having potential anti-alzheimer effects 

Cornel iridoid glycosides loganin isolated in the fruits of Cornus 

officialis improves memory deficits and tenuates hippocampal neuronal loss by 

improving the brain improvement for repair and promoting neuronal survival.  

Oleanolic acid, tenuifolin is triterpene has reported to be beneficial for AD. 
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A screening effort to identify potent AchE inhibitors from medicinal 

herbs leads to isolation of ursolic acid.Ursolic acid competitively inhibits AchE 

in dose dependent manner. 

FLAVANOIDS AS ANTI-ALZHEIMER AGENTS 

Flavanoids are a class of secondary metabolites that always attract the 

attention of pharmaceutical industry due to their versatility in therapeutic 

properties.More than 9000 flavanoids have been identified.
[43] 

Fiavanols (rutin,quercetin,catechin,epicatechin), Isoflavanes(glycetin), 

Flavanones, Flavanes, Anthocyanins etc.are used to treat AD. 

Flavanoids highlight the potential effects against AD by protect neurons 

against oxidative stress,subsequently reduce the reactive oxygen species 

production suppresses the neuro-inflammation. 

 

Fig:6  Herbs used for Alzheimer disease.
[23] 
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IN VITRO ANTI-ALZHEIMER MODEL 

The bioactive compounds needed to be validated by in vitro and in vivo 

model.The anti-alzheimer compounds are assayed by in vitro 

acetylcholinesterase inhibition assay.The acetylcholinesterase enzymes are 

involved in the breakdown of neurotransmitter substance 

Acetylcholine.Therefore inhibition of acetylcholinesterase enzyme leads to 

availability of neurotnsmitter acetylcholine which delays the development of 

disease.
[24] 

 

Fig:7   Inhibition of acetylcholinesterase enzyme
[26,27] 
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BIOACTIVE COMPOUNDS 

 

Inhibits acetylcholinesterase enzyme 

 

Prevents breakdown of acetylcholine into choline and acetate in synaptic cleft 

 

Increase the availability of neurotransmitter acetylcholine in post synaptic 

membrane 

 

Anti-alzheimer activity
[24] 

IN VIVO ANTI-ALZHEIMER MODEL 

Scopolamine induced Alzheimer disease 

Scopolamine is muscarnic receptor antagonist which blocks cholinergic 

neurotransmission leading to memory impairement.Scopolamine is used to treat 

motion sickness and antispasmodic.Administration of Scopolamine leads to 

increasing beta-amyloid deposition and increase in reactive oxygen species 

results in deficits in memory.
[28] 

MOLECULAR DOCKING APPROACH 

The molecular docking study was performed to findout the potential 

molecular target for natural anti-alzheimer compounds.The docking study was 

carried out by using software such as as AutoDock
®

, Argus lab
®

, Glide
®

 

etc.The docking score (binding energy)reveals that the compounds contained in 

the extracts of plants have capacity to be used as inhibitor for Alzheimer target.  
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LIST OF SOME PATENTS FOR HERBAL TREATMENTS OF 

ALZHEIMER 

PATENT 

APPLICATION 

NUMBER 

TITLE INVENTION 

US20020146467A1 Herbal 

composition 

for the 

treatment and 

prevention of 

dementia 

The present invention relates to herbal 

composition for the prevention of 

dementia comprising Polygonium 

multiflori(Polygonium  

multiflorum),Polygalae 

radix,Caryophyllus flos,Xingiberis 

Rhizoma crodus in conventional herb 

composition to maximize anti-

dementia effect with minimal 

amount.
[29] 

US7429397B2 Herbal 

formulation as 

memory 

enhancer in 

Alzheimer 

condition 

This invention provides a novel herbal 

formulation used as brain 

tonic,improves memory nd helps in 

recalling of thoughts.
[30] 

In this present research,the plant Oxystelma esculentum R.BR has 

been selected. The literatures pertaining to phytochemical evaluation are very 

scarceand anti-alzheimer activity has not been investigated.Hence an attempt 

has been made to evaluate the invitro and invivi anti-alzheimer activity of 

aerial parts of Oxystelma esculentum R.BR. and to isolate the active 

constituent from active extract responsible for anti-alzheimer activity.The 

isolated pure compound has been attempted for molecular docking analysis.  
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CHAPTER – 2 

REVIEW OF LITERATURE 

 

PHYTOCHEMICAL REVIEW OF OXYSTELMA ESCULENTUM R.BR 

1. Savitha S and   Balamurugan S; (2016)
[45]

 evaluated the 

phytochemical constituents in the extracts of Oxystelma esculentum 

R.BR with pet ether, chloroform, ethyl acetate, methanol as solvents. 

The phytochemical analysis of plant revaled the presence of alkaloids, 

tannins, steroids, saponins, terpenoids, flavanoids, glycosides and 

phenolic compounds. All these extracts show various level of 

antimicrobial activity but methanol extract shows potent antimicrobial 

activity. 

2. Pandya DJ  and Anand IS; (2012)
[46]

 isolated epicatechin from 

methanlic extract and Kaempferol from pet ether extract Oxystelma 

esculentum R.BR.and their structure were elucidated. 

3. Poornima.N and Umarajan KM;(2009)
[47]

 determined the anatomical 

features of Oxystelma esculentum R.BR. root, rhizome, stem, leaf, 

petiole for description of its purity and identity and also investigated the 

phytochemical analysis revealed the presence of tannins, flavanoids, 

terpenoids, cardiac glycosides and alkaloids.  

4. Durairaj Ashok Kumar et al; (2008)
[40]

evaluated the antioxidant and 

free radical scavenging properties of Oxystelma esculentum R.BR. The 

total antioxidant activity of methanol extract of O.esculentum increases 

with increasing concentration. The methanol extract scavenges the 

hydrogen peroxide in dose dependent manner. Finally the extract of 

O.esculentum proved its strong anti oxidant activity and used as a 

natural antioxidant. 

  



Review of Literature 

Department of Pharmaceutical Chemistry, COP, MMC. Page 16 

ANTI-ALZHEIMER  ACTIVITY  OF  OTHER  MEDICINAL  PLANTS 

5. Vaishali J Mahadik and Monika N; (2020)
[48]

 performed  the cognition 

enhancing effect  of various extracts of fruits of Sesbania glandiflora, 

pet ether extract, benzene extract, chloroform extract, acetone extract 

and ethanolic extract in scopolamine induced amnesia mice. Morris 

water method and Elevated plus maze method  was done to evaluate the 

cognitive performance. Scopolamine was used to induce amnesia and 

Piracetum was used as standard. Various biochemical parameters such as 

acetylcholinesterase, glutathione, malondialdehyde from brain 

homogenate were evaluated. Pretreatment with various extracts possess 

cognition enhancing  property in scopolamine induced amnesia mice  

6. Prachi Saini et al; (2019)
[49]

 investigated in vivo anti-alzheimer activity 

in amnesia induced albino mice from isolated compounds Karanjin and 

Embelin. Karanjin was isolated from Pongomia pinnata and Embelin 

from Embelia aribes. The anti-alzheimer activity of isolated compounds 

is evaluated through elevated plus maze model and Morris water maze 

model on swiss albino mice. Diazepam was used for induction of 

Alzheimer effects and Piracetum was used as standard treatment. The 

increase and decrease in transfer latency was recorded in elevated plus 

maze model. The isolated compounds and standard significantly 

reversed amnesia induced by diazepam and improved learning and 

memory of mice in dose dependent manner.  

7. Anil Yilmaz and Mehmat Boga; (2016)
[50]

 isolated two terpenoids 

from diclromethane extract and two novel terpenoids from ethanol 

extract of Nepta obtusicrena. These isolated novel terpenes shows anti-

alzheimer activity by lipid peroxidation inhibition and potent 

acetylcholinesterase inhibition. 
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REVIEW ON ALZHEIMER TARGET PROTEIN 

8. Hemalatha S, Jason Tom Abraham; (2021)
[58]

 docked the potential 

compounds of Brassus flabellifer against the Alzheimer target proteins 

acetylcholinesterase and β-secretase enzyme. Five compounds showed 

best interaction with acetylcholinesterase and three compounds showed 

best interaction with β-secretase 

9. Zhen Zhong et al; (2018)
[57]

 evaluated potential ability of Gingko 

biloba to bind with acetylcholinesterase enzyme by molecular docking. 

Docking results indicated the ligand bind tightly with the active site of 

human acetylcholinesterase, with hydrogen bond interactions. Among 

the different isolated compounds of Ginkgo biloba Diosmetin compound 

was found to be the best predicted docking score.  

10. Rithvik Ganesh et al; (2017)
[56]

 performed molecular docking studies 

of plant alkaloid derivatives as inhibitors of various drug targets of 

Alzheimer disease. 150 derivatives of Curcumin, Bacopaside, Ginkolide 

B are docked with multiple target proteins β-secretase, cholinesterase, 

tau proteins.Results are found to be 23 ligands are good fit with the drug 

target. Ginkgolide B shows excellent binding studies with the multiple 

drug targets.The proposed drug act as cholinesterase inhibitor, thus used 

as symptomatic drug to relieve Alzheimer disease. 
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CHAPTER – 3 

AIM AND OBJECTIVES 

AIM 

To  isolate, characterize and evaluate an Anti-alzheimer activity from 

the aerial parts of  Oxystelma esculentum R.BR. 

OBJECTIVES 

 To   carryout   successive  extraction  on   dried   powdered  leaves   of   

Oxystelma esculentum   R.Br. by  hot  continuous  percolation  in  

soxhlet   apparatus   using solvent such   as   Hexane,  chloroform,   

ethyl   acetate   and   ethanol. 

 To carry out preliminary phytochemical screening   for   the    extract   

for   the detection   of   active   constituens. 

 To   perform   bioactive   guided   isolation. 

 The   extracts   were   planned   to   undergo   in   vitro  anti 

Alzheimer  activity   by   acetylcholinesterase   inhibition   

assay. 

 Based   on   IC50   values   of   all   the   extract   against 

acetylcholinesterase   an active   extract  will  be   selected   for  

isolation   by   column   chromatographic  method.  

 Acute   toxicity   study   will   be   carried   out   for   an   active   

extract   by OECD423 guidelines. 

 The active   extract of   safer   dose   1/5
th  

 and   1/10
th

   will   be   

subjected   for   in-vivo Anti-alzhiemer study in Scopolamine induced 

amnesia mice. 

 To   carryout   isolation   of    selected   active   extract   by   column 

chromatography using   gradient   elution   technique. 
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 The  active  extract  will  be  subjected  for  analysis  by  Quadrapole  

Time of  Flight (QTOF)  for  library database.  

 To   evaluate  in  vitro  anti-alzheimer  activity  of  an  isolated 

compound. 

 The  isolated compound will be characterized  by  UV,  IR,  
1
H-NMR. 

 To evaluate in-silico molecular properties of an isolated compound by 

Molinspiration Cheminformatics
®

  software tool. 

 To perform molecular docking studies of the isolated compound on 

Alzheimer target protein using Autodock
®

 software Version1.5.6. 
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CHAPTER – 4 

SCHEME OF WORK 

 

 

Fig:8. Outline of research 
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CHAPTER – 5 

PLANT PROFILE 

 

Fig-9: Plant of Oxystelma Esculentum R.BR
[37] 

OXYSTELMA ESCULENTUM R.BR. 

Synonym : Oxystelma Alpine Decne 

Family            : asclepiadaceae 

Vernacular names
[38] 

English : Rosy Milkweed Vine 

Tamil                 : Usippaalai 

Telugu                : Dudhipala 

Malayalam         : Kulapala 

Kannada             : Dugdhika 

Marathi               : Dudhani 

Gujarathi             : Jaladhudhi 

Hindi                   : Dudhialata 
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Habit                   : Twinging Subshrubs 

Habitat                : Moist Ground Canal Banks. 

Colour of the flower   : Whitish Purple 

Distribution                  :  Uttarpradesh, Maharastra, Andhrapradesh, 

Bihar, Tamilnadu (Pudukottai, Kanyakumari, 

Coimbatore) 

Description 

Rosy milkweed vine is a perennial creeper, which becomes 1-2m long.it 

has fibrous roots emerging from lower nodes of stem.
[41]

 numerous 

slender,twinning stems are branched. Oppositely arranged linear-lance like 

leaves with round bases are 4-6 cm long. White purple handsome flowers 

occurs as raceme like cymes 10-15 cm long.flowers can be sometimes almost 

white. The drooping,5 petalled,sauce shaped flowers are pink purple veined. It 

has corona of 5 erect lobes in the centre lance like follicles are 3-6 cm long and 

are edible. The plants are good source of famine food.
[37] 

Flowering of this plant is from July to February 

Constituents
[42] 

 Pregnane glycosides 

1. Oxysine 

2. Oxyline 

3. Esculentum 

 Cardenolides 

1. Oxystelmoside 

2. Oxystelmine 

 



Plant Profile 

Department of Pharmaceutical Chemistry, COP, MMC. Page 23 

 Flavanoids 

 Terpenoids 

 Cardiac glycosides 

Medicinal uses
[41] 

The plant has many therapeutic uses which are vital importance in 

curing the modern world like 

 Cancer, 

 Hepatitis, 

 Kidney disorders, 

 Stress related disorders and 

 Microbial infections. 
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CHAPTER-6 

MATERIALS AND METHODS 

6.1 COLLECTION OF PLANT 

The leaves of Oxystelma esculentum R.BR. were collected from Tamil 

Nadu(forest of kalakatu) Tirunelveli District,India. Taxonomic identification 

was made from botanical survey of medicinal plants, Siddha Unit, Government 

of India, Palayamkottai authenticated by V.Chelladurai Botanists. 

Authenticated register No:XCH 40379. Fresh aerial parts of the plant were 

shade dried at room temperature, ground into coarse powder and stored in 

airtight  containers. 

6.2 PREPARATION OF PLANT EXTRACTS 

The dried powdered aerial parts of Oxystelma esculentum R.BR. was 

extracted sequentially by hot continuous percolation method by Soxhlet 

apparatus using hexane, chloroform, ethyl acetate and ethanol as 

solvent.The collected extracts were concentrated by using rotatory vacuum 

evaporator and kept in desiccator. 

 

Fig:10. Soxhlet extraction process of Oxystelma esculentum. R.BR.  
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6.3 PRELIMINARY PHYTOCHEMICAL ANALYSIS OF EXTRACTS 

All the extracts were subjected to preliminary phytochemical screening 

for the detection of various plant constituents present.The nature of the 

constituents present in the plant helps to determine the biological and 

pharmacological activity. The hexane, chloroform,ethyl acetate and ethanolic 

extracts of Oxystelma esculentum R.BR.was subjected to the following 

chemical tests to identify the various active constituents present.
[31,32,33]

 

TESTS FOR ALKALOIDS 

DRAGENDROFF'S TEST 

The extract was treated with Dragendroff’s reagent and observed for the 

formation of yellow colored  precipitate indicates the presence of  alkaloids.  

WAGNER'S TEST 

The extract was treated with Wagner's reagent and observed for the 

formation of a reddish-brown precipitate indicates the presence of the 

alkaloids. 

MAYER'S TEST 

The extract was treated with Mayer’s reagent formation of white 

precipitate or creamy coloured precipitate indicates the presence of alkaloids.  

HAGER'S TEST 

The extract was treated with Hager's reagent and observed for the 

formation of yellow precipitate indicates the presence of alkaloids.  

TEST FOR CARBOHYDRATES 

MOLISCH'S TEST 

To 2ml of the extract 1ml of alpha-naphthol solution was added and 

concentrated sulphuric acid was added through the sides of test tube. Purple or 

reddish violet color at the junction of the two liquids revealed the presence of  

carbohydrates. 
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FEHLING'S TEST 

To 1ml of the extract equal quantities of Fehling's solution A and B 

were added while heating formation of a brick red precipitate that indicates the 

presence of  carbohydrates. 

BENEDICT'S TEST 

To 5ml of Benedict’s reagent 1ml of the extract solution was added and 

boiled for 2minutes and cooled.Formation of red precipitate shows the presence 

of carbohydrates. 

TESTS FOR GLYCOSIDES 

LEGAL'S TEST 

The extract was dissolved in pyridine and sodium nitroprusside solution 

was added to make it an alkaline.The formation of pink red to red color shows 

the presence of glycosides. 

BALJET TEST 

To 1 ml of the ethanolic extract was added with 1 ml sodium picrate 

solution and the yellow to orange color reveals the presence of  glycosides.  

BONTRAGER’S TEST 

A few ml of dilute Hydrochloric acid was added to1ml  of the extract 

solution .It was then boiled,filtered and the filtrate was extracted with 

chloroform.The chloroform layer was then treated with 1ml of ammonia. The 

formation of red color shows the presence of anthraquinone  glycosides.  

KELLER KILLIANI TEST 

The extract was dissolved in acetic acid containing traces of ferric 

chloride and it was then transferred to a test tube containing sulphuric acid. At 

the junction,formation of a  reddish brown color, which gradually became blue 

confirms the presence of glycosides. 
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TESTS FOR PHYTOSTEROL 

LIBERMANN BURCHARD TEST 

3ml of extract was mixed with 3ml of acetic anhydride. It was heated 

and then cooled. Few drops of concentrated sulphuric acid were added. 

Appearance of blue color shows the presence of phytosterol.  

SALKOWSKI'S TEST 

Dissolve the extract in chloroform and equal volume of concentrated 

sulphuric acid was added. Formation of bluish red to cherry red color in 

chloroform layer and green fluorescence in the acid layer represents the steroid 

components present in the extract. 

TEST FOR FLAVONOIDS 

SHINODA TEST 

The extract was treated with 5ml of 95%ethanol.Add few drops of 

concentrated hydrochloric acid and 0.5g of magnesium turnings. Pink color was 

observed which shows the presence of flavonoids.  

TEST FOR TANNINS AND PHENOLIC COMPOUNDS 

FERRIC CHLORIDE  TEST 

1ml of the extract was added with ferric chloride and observed for the 

formation of a dark blue or greenish black color indicates the presence of 

Tannins and Phenolic compounds. 

GELATIN TEST 

The extract was treated with 1%gelatin containing 10% NaCl and 

observed for the precipitation which indicates the presence of Tannins and 

Phenolic compounds. 
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TESTS FOR PROTEINS AND AMINOACIDS 

BIURET TEST 

1ml of the extract was treated with 1ml of 40% sodium hydroxide 

solution followed by 2drops of 1% copper sulphate solution. Formation o f a 

violet color shows the presence of  proteins.  

XANTHOPROTEIC TEST 

1ml of the extract was treated with 1ml of concentrated nitric acid. A 

white precipitate was formed, it was boiled and cooled. Then 20% of sodium 

hydroxide or ammonia was added orange color was formed indicates the 

presence of aromatic amino acids. 

LEAD ACETATE TEST 

The extract was treated with 1ml of lead acetate. Formation of a white 

precipitate indicates the presence of  proteins.  

TEST FOR SAPONINS 

About 1 ml of ethanol extract was diluted separately with distilled water 

to 20 ml and shaken in a graduated cylinder for15minute s.A1%1cm  layer of 

foam  indicates the presence of  saponins. 

TEST FOR FIXED OILS 

SPOT TEST 

A small quantity of the extract was pressed between two filter papers. 

Oil stains on the filter paper indicates the presence of fixed oils.  
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6.4 IN VITRO ANT-IALZHEIMER ACTIVITY ON EXTRACTS OF 

OXYSTELMA ESCULENTUM R.BR. BY ACETYLCHOLINESTERASE  

INHIBITION  ASSAY 

All the four extracts were subjected to in-vitro anti-Alzheimer’s activity 

by acetylcholinesterase enzyme inhibition assay.  

Procedure 

Acetylcholinesterase  Inhibition  Assay 

The acetylcholinesterase inhibitor activity of the test samples 

(hexane,chloroform, ethyl acetate and ethanol) where assayed by the  following 

adaptation of spectrophotometric method reported by elman et al.[34]  

The cuvette used as a blank to control for the nonenzymatic hydrolysis 

of acetylcholine contained a mixture of 500 μL of 3mM DTNB solution (in 

0.1M potassium phosphate pH 8), 100 μL of 15mM AChI (in water), 275 μL of 

0.1Mpotassium phosphate pH 8, and 100 μL of each cork and corkback 

ethanol-water extract solutions at the different concentrations (25, 

50,100,200,400 and 800 µg/ml). In the reaction cuvette, 25 μL of buffer was 

replaced by AChE solution 0.16 U/mL. The resulting solutions were placed in a 

spectrophotometer. The thiocholine formed during the hydrolysis of 

acetylcholine reacts rapidly with DTNB and a yellow compound is formed. The 

reaction was monitored for 5 min at 405nm and the absorbance registered every 

minute. Velocities of reaction were calculated Enzyme activity was calculated 

as a percentage of the velocities compared to that of the assay using buffer 

solution instead of inhibitor (cork or corkback ethanol-water extracts). Positive 

assays were performed in triplicate. 

% of inhibition = [(OD of control - OD of test)/(OD of control)]×100 

The extract Exhibiting minimum IC50 value was selected as an active 

extract far isolation of anti-Alzheimer’s compound using column 

chromatography. 
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6.5. ACUTE TOXICITY STUDY OF ACTIVE EXTRACT OF 

OXYSTELMA ESCULENTUM R.BR.IN MICE 

Determination of acute oral toxicity is usually the initial screening step 

in the assessment and evaluation of the toxic characteristics of all compounds. 

The types of toxicity tests which are routinely performed by pharmaceutical 

manufacturers in the investigation of new drug involved in acute, sub-acute and 

chronic toxicity. Acute toxicity is involved in estimation of LD50(the dose 

which has proved to be lethal(causing death) to 50% of the tested group of 

animals). 

The acute toxicity study of active ethanolic extract of Oxystelma 

esculentum R.BR. will be carried out as per (OECD) draft guidelines 423. The 

acute toxic class method is based on biometric evaluation with fixed doses, 

adequately separated to enable a substance to be ranked for classification  

purpose and hazard  assessment.
[35] 

ACCLIMATIZATION OF ANIMALS: 

OECD 423 guidelines will be followed. Swiss albino mice (25-30g) 

were obtained from the Centre for experimental animals in Madras Medical 

College (CPCSEA Registration no: 1917/GO/ReBi/2016/CPCSEA valid till 19-

09-2026). After seven days of acclimatization,the three mice were randomly 

assigned for the acute toxicity groups. Animals will be allowed free access to 

standard pellet diet and water ad libitum. They will be maintained in controlled 

laboratory conditions of 12 hours dark/light cycle 22±2ºC temperature and 45-

60% humidity. 

ADMINISTRATION OF ACTIVE EXTRACT 

The three mice were made to fasting prior to dosing (food was 

withdrawn overnight and water was withdrawn 3hrs before drug administration) 

following the period of fasting. The animals are weighed and the ethanol 

extract was administered in a single dose,as 1% suspension in carboxy methyl 

cellulose by oral intubation. Food was withheld for further one hour after the 
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administration of drug. The starting dose  level was selected for the study with 

a dose of  2000mg/kg body  weight. 

OBSERVATIONS 

Animals were observed individually after dosing periodically during the 

first 30 minutes to first 24 hours ,with special attention given during the first 4 

hours and daily thereafter, for a total of 14 days. The time at which signs of 

toxicity appear and disappear was observed systematically and recorded for 

each animal. 

Additional signs of toxicity such as changes in bodyweight, skin and fur, 

eyes and mucus membranes, respiratory system, circulatory system, 

autonomous system and central nervous system, somato motor activity and 

behaviour pattern were also recorded. Attention was given to observe the 

tremors, convulsions, salivation, diarrhea, lethargy, sleep and coma. 

The mice will be observed regularly for 14 days to note the compound 

related mortality/morbidity or other toxic symptoms. Any mortality during the 

experiment for 14 days was observed and recorded. If  no deaths were 

reported,the study was repeated with same dose to confirm the results.1/5
th 

and 

1/10
th 

of the safer dose will be selected for in vivo study. 

6.6 In vivo anti-Alzheimer activity (Scopolamine induced amnesic mice)  

Grouping and induction of amnesia 

A total of 30 Swiss male mice were selected in this study which weighed 

approximately 20–30 g each, aged 6–7 weeks old. 

The animals were divided randomly into five groups, each consisting of 

six animals. The animals had water ad libitum and food pellets. They were 

allowed to acclimatize to the laboratory environment for a week before the 

experiments. Group I, Control, was administered with normal saline orally and 

Group II, Negative Control, was administered with scopolamine 1mg/kg 

i.p.[54,36] 
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Groups III and IV were treated orally with a low dose of an extract of 

Oxystelma esculentum R.BR. and a high dose of an extract of Oxystelma 

esculentum R.BR. respectively, and induced with amnesia. Group V, standard, 

Donepezil will be administered orally.  The experimental study and the drug 

treatment (extract & standard) duration was 15 days; scopolamine 1 mg/kg 

body weight (Deng et al., 2019) was administered i.p from the 8th day to the 

14th day in Groups II, III, and IV & V. On the day of the behavioural test, the 

extract & standard (Donepezil) was administered 1 hour prior to the test.[51] 

Table-1: Grouping of animals and their doses. 

Group Drug Treatment 
No. of. 

Animals 

1.  Control Normal  saline 06 

2.  
Disease 

control 
Scopolamine(1mg/kg) 06 

3.  Test dose 1 
Scopolamine+ low dose of active 

extract 
06 

4.  Test dose  2 
Scopolamine+ high dose of active 

extract 
06 

5.  Standard Scopolamine +donepezil(5mg/kg) 06 

Behavioural study Y-maze test 

Y-maze with the specifications of 40 x 8 x 15 cm (L x W x H) will be 

used. The arms were constructed in such a way that they are 120°C 

symmetrically disposed to each other. The floor was made up of dark opaque 

polyvinyl plastic. On the 15th day of the treatment, 1 hour before the test, the 

extract and donepezil were treated in the treatment group and all the mice were 

subject to the test. All the three arms of the maze were labelled as A, B, and C, 

respectively. The mice were placed at the end of the arm labelled “A” and one 

food pellet was placed at all the three arms in order to motivate the movement 

of the mice. 

Each arm of the maze is labelled as either arm A, B, or C. In each 

session, the animal is placed in arm B and allowed to explore the three arms for 
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5 minutes.  Number of arm entries and number of alternations are scored live in 

order to calculate the percent alternation. The entry is considered when all four 

limbs are within the arm. The alternation percentage is calculated by dividing 

the number of alternations by number of possible triads x 100. The maze is 

cleaned with Virkon solution or 70% alcohol between animals to eliminate 

odour traces. 
[53] 

Open-Field Test 

The open-field test is used to provide a qualitative and quantitative 

measurement of exploratory and locomotor activity in rodents. The apparatus 

consists of an arena surrounded by high walls, to prevent escape, and the floor 

of the open field is divided into squares. The Open Field Test measures 

hyperactivity through locomotion, exploration and anxious behaviour. The 

open field box consisted of a square box (60cm x 60cm x 25cm); made out of 

plywood with outlined a series of squares. 

The open field represents a new stressful environment for the animal and 

allows for evaluation of locomotor activity, level of exploration, and emotional 

response in animals, in a single day. Animals that received Scopolamine and 

were analysed for memory in the Y-maze were immediately placed in the open 

field. The following parameters were noted for a period of 5 minutes for each 

mouse: the number of “crossing” (number of crossed lines or crossed tiles), the 

number of “rearing” (when the animal is placed on its hind legs by resting on 

the wall of the device with its front legs), and the time spent in the centre
.[53] 

TRACTION TEST 

The effect of scopolamine, as well as the extract of O.esculentum, on 

motor co ordination of the mice was evaluated using the traction test.The 

experimental set up was done using a horizontal bar of 12 mm in size, one 12 

inch length fixed in two poles at a height of 40 cm. The height of set up allows 

the animl sufficient time and space to land by losing muscle grip on its feet due 

to righting reflex.The setup was arranged on the tabletop and the animals were 

allowed to get a grip with their hind limbs on the horizontal bars.The total 

motivation time in seconds to hang on to the bar from the aversion to  falling is 
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considered as grip index.The motivation time is considered to be proportional 

to muscle grip strength and balance. Once done with setup, the mice were 

suspended on the static bar and time taken for the mice to re establish 

themselves and retain on the bar was recorded
.[53] 

Biochemical  studies 

Tissue Preparation. 

Immediately after the behavioural tests, the mice were sacrificed by 

cervical decapitation, and then, the brains were quickly removed and placed in 

boxes containing frozen saline for its solidification for 10min. The brain was 

introduced into a graduated cylinder followed by the addition of PBS (pH 7.4) 

to obtain the 10% homogenate. Each tube was centrifuged at 10000 rpm/min at 

4° C for 15minutes, and the supernatant was collected for biochemical 

analysis.
[54] 

Estimation  of  Malondialdehyde. 

A MDA assay was performed according to the protocol described by 

Wilbur et al. [21], with some modifications. For this assay, 500 ml of 

homogenate was introduced in the test tubes and 500 μl of Tris-HCl buffer (50 

mM, pH 7,4 ) in the control tube. In each tube, 250 ml of trichloroacetic acid 

(TCA) 20% and 500 μl of TBA 0.67% were added. The tubes were closed with 

glass beads and then incubated in water bath for 10 min at 90° C. They were 

then left in room temperature for cooling before being centrifuged at 3000 rpm 

for 15 minutes. The supernatant was piped, and the absorbance was read with a 

spectrophotometer at 530 nm against the control. The concentration of MDA in 

mol/g was determined using the formula of Beer Lambert using the molar 

extinction coefficient 1:56 × 105 mmol-1 cm-1 

Estimation  of  Catalase  activity. 

The activity of catalase was measured by the method of Aebi. In 0.1 ml 

of supernatant, 1.9 ml of 50 mM phosphate buffer (pH 7.0) was added. The 

reaction was initiated by the addition of 1.0 ml of newly prepared 30 mM 
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H2O2. The rate of decomposition of H2O2 was measured by spectrophotometry 

from absorbance changes at 240 nm. Catalase activity was expressed in 

units/mg protein. 2.8.3. 

Estimation  of  Reduced Glutathione (GSH). 

The reduced glutathione (GSH) was assessed in the brain supernatant 

using Ellman’s reagent as described by Ellman [24]. Twenty (20)μl of brain 

homogenates was mixed with 3 ml of Ellman’s reagent at room temperature. 

After one hour, the absorbance of the yellow compound was read at 412 nm 

using a spectrophotometer. The amount of glutathione was calculated with the 

formula of Beer-Lambert using the extinction coefficient value of 13.600 mol-1 

cm-1. 

Statistical analysis 

Data is reported as Mean +_ SEM. Statical comparisons were 

determined by analysis of variance (ANOVA) and means were separated using  

Duncan’s multiple range test (P<0.05).  

6.7 Isolation of active extract by column chromatography 

The ethanolic extract was active and shows better in vitro anti-

Alzheimer activity compared to other extracts.Hence the bioactive guided 

isolation was performed and the ethanol extract will  be subjected for column 

chromatographic isolation by gradient elution technique.  

Column Packing 

 Dry packing technique was employed for the isolation by column 

chromatography. 

 Initially cotton plug is kept at the bottom of the column and preheated 

silicagel(100-200mesh size) was added to3/4
th

 of the column length. 

 Then, 20 gm of ethanol extract was dissolved in 20 ml of ethanol to 

dissolve the extract completely, if any debris found,it was filtered.  
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 The clear liquid was then adsorbed by silica gel (60-120 mesh size) with 

constant stirring. Then it is kept in incubator at 40˚c for 3 hours to obtain 

free flowing powder. This flowing powder was packed above the silicagel  

bed. 

 A few grams of silica gel are added on the top of the sample and cotton 

was kept overit. 

 The mobile phase (100 % Hexane) is continuously run over the column for 

about 5-6 times for tight packing of the column. 

Elution Process – Gradient Elution Technique 

The ethanol extract was eluted by gradient elution technique using 

various solvent systems. The collected elutes was marked as fractions and 

collected in a beaker. Further, TLC was performed for all fractions to identify 

the fraction which exhibits similar Rf value .The fractions sshowing similar Rf 

value was mixed together and evaporated.The fractions which shows single 

spot in UV (254nm and 366nm) and in iodine chamber is considered as pure 

and can be designated as an isolated compound.
[57] 

Table-2: Solvent composition for Isolation 

S. 

no 

Solvent 

system 
Solvent ratio 

1. Hexane 100% 

2. Hexane: 

Ethyl 

Acetate 

95:5,90:10,85:15,80:20,75:25,70:30, 65:35,60:40, 

55:45,50:50,45:55,40:60, 35:65,30:70,25:75,20:80, 

15;85,10:90,5:95 

3. Chloroform 100% 

4. Chloroform: 

Ethyl acetate 

97:3,94:6,91:9,88:12,85:15,82:18,79:21, 76:24,73:27,70;30, 

67:33,64:36,61:39,58:42, 55:45,52:48,49:51,46:54,43:57, 

40:60,37:63, 34:66,31:69,28:72,25:75,22:78,19:81,15:85, 10:90 

5. Ethyl acetate 100% 

6. Chloroform: 

Ethanol 

98:2,96:4,94:6,92:8,90:10,88:12,86:14,84:16, 82:18,80:20, 

78:22,76:24,74:26,72:28,70:30, 68:32,66:34,64:36, 62:38, 

60:40,58:42, 56:44,54:46,52:48,50:50,45:55,40:60, 35:65, 

30:70, 25:75,20:80,15:85,10:90 
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6.8. In vitro anti-alzheimer activity of isolated compound by 

acetylcholinesterase inhibition assay 

Acetylcholinesterase  inhibition  assay 

The effect of isolated compound on acetylcholinesterase inhibitory 

activity will be determined using acetylcholinesterase enzyme.where assayed 

by the following adaptation of spectrophotometric  method  reported by  Elman 

et al.
[34] 

The cuvette used as a blank to control for the non enzymatic hydrolysis 

of acetylcholine contained a mixture of 500 μL of 3mM DTNB solution (in 

0.1M potassium phosphate pH 8), 100 μL of 15mM AChI (in water), 275 μL of 

0.1Mpotassium phosphate pH 8, and 100 μL of each cork and cork back 

ethanol-water extract solutions at the different concentrations (25, 

50,100,200,400 and 800 µg/ml). In the reaction cuvette, 25 μL of buffer was 

replaced by AChE solution 0.16 U/mL. The resulting solutions were placed in a 

spectrophotometer. The thiocholine formed during the hydrolysis of 

acetylcholine reacts rapidly with DTNB and a yellow compound is formed. The 

reaction was monitored for 5 min at 405nm and the absorbance registered every 

minute. Velocities of reaction were calculated Enzyme activity was calculated 

as a percentage of the velocities compared to that of the assay using buffer 

solution instead of inhibitor (cork or cork back ethanol-water extracts). Positive 

assays were performed in triplicate. 

Acetylcholinesterase inhibition = [(OD of control - OD of test)/(OD of control)]×100 

6.9 Characterisation of isolated compound 

The isolated compound will be characterized by following analytical 

techniques 

-UV spectroscopy, IR ,
1
H-NMR and Mass spectroscopy.

[59] 

6.10 In-silico molecular property prediction of isolated compound 

The isolated compound was evaluated for molecular property by 

Molinspiration Cheminformatics software tool.This tool will evaluate the logP 
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prediction,Aqueous solubility, Molecular weight,Fragment based drug 

likeness,Overall drug score etc., directly from the chemical structure.  

The Violations of Lipinskis rule of 5 for this compound is predicted by 

using this tool. 

6.11 Molecular docking study of isolated compound against Alzheimer 

target protein 

Molecular docking is generally used to detect the protein-ligand 

orientation and interaction. Autodock Tools package version 1.5.6 was utilized 

to create the docking input files.The grid region was surrounded by the active 

site for binding. So, grid region was selected on the basis of amino acid 

residues representing the binding site of Rivastigmine as the standard drug 

obtained from PDB ID- 1 GQR( Human Acetylcholinesterase)
[56]

, 1 SGZ (β-

SECRETASE)
[57,58]

 and considered as the best active region for the favorable 

interaction.The gridbox was set at 126×126×126A˚forx,y and z axis and 

covered the active site of the target protein. The Lamarckian Genetic Algorithm 

(LGA), a local search algorithm was utilized for ligands conformers searching. 

During the docking process, a maximum of 10 conformers were considered for 

the compound. After completion of the conformer the lowest binding energy 

was chosen. The conformational similarity by visualizing the binding site and 

its energy (Kcal/mol) and the docked amino acid residues forming hydrogen 

bonds and other parameters like intermolecular energy(Kcal/mol) and 

inhibition constant(μM) were analyzed by Autodock tool. Ten best poses were 

generated for the ligand and score during Auto Dock- 
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Fig 11: 3D structure of Human acetylcholinesterase 

 

Figure 12. Structure of β-secretase 



Materials and Methods 

Department of Pharmaceutical Chemistry, COP, MMC. Page 40 

AUTODOCK  and  ADT 

Short Tutorial: 

Overview: 

Working with  Auto Dock4  includes  3  steps: 

1. Preparation of receptor & ligand files. 

2. Calculation of affinity maps by using a 3D grid around the  receptor & 

ligand. 

3. Defining the docking  parameters and running  the docking simulation.  

The preparation step starts with pdb files of receptor (protein.pdb) and 

ligand(ligand.pdb), which are added hydrogens and then saved as protein.pdb & 

ligand.pdb.The calculation of affinity maps in the "Grid" section requires the 

above pdb files to be assigned charges & atom types, and also that the nonpolar 

hydrogens are merged. This is done automatically by ADT,and the resulting 

files need to be saved as protein.pdbqt & ligand.pdbqt, which is the only format 

AutoGrid& Autodock can work with .Calculation of affinity maps is done by 

AutoGrid and then docking can be done by Autodock. The newest  docking  

algorithm is LGA (Lamarckian Genetic Algorithm). 

For running  ADT, you should  be  following  next  steps:  

1. Install MGL tools. 

2. Download autogrid4.exe,autodock4.exeandAD4.1_bound.datfiles.  

3. Install Molegro  Molecular Viewer. 

4. Install ChemDraw  including   3DPro. 

After having finished installation of above tools, you can run ADT. 

Here, I recommend you to follow my current protocol for running it:  

1. Create a work folder for your job and tag it based on your favorite 
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name.(e.g.project) 

2. Running ADT in start menu in windows: after running you should set its 

directory:following these steps: 

a) Open ADT> File> Preferences>set>Startup Directory (in this 

section you should put on work folder path and set it). for 

example: “C:\Users\project 

3. prepare ligand and protein in ".pdb" format. Notice, you must have 

labeled them by"Ligand" and "Protein" keywords. Protein can be 

preprocessed byMolegro Molecular Viewer& Ligand can be initially 

prepared using in Chem Bio Draw and can  be saved as pdb. 

After having finished these steps you can open ADT: Well! you should do 

the below ways: 

1-openADT: 

File>Read Molecule>Select Protein File(“.pdb”file)Then,  

Edit>Hydrogens>Add>Polar Only >OK . 

Edit >Hydrogens> Merge Non-Polar >Continue (in this step if you see 

any warning please click on "continue") then: 

Edit >Charges>Compute Gasteiger>Ok 

Edit>Misc>Repair Missing Atoms>Ok/Select all> Dismiss 

File > Save > Write PDB>>Sort Nodes (Check) > OK > (Overwrite) 

YES 

Well! in the next step you should try prepare the 

ligand:Ligand>Input>Open>SelectLigand File (“.pdb” file) > OK  

Now repeat above steps and then: (in this section you must add charge to 

your ligand. 
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So, click on Edit menu and: 

Edit> Charges> Add Kollman charges 

Ligand >Output>Save as PDBQT 

**************************************************************** 

Now you should be executing AutoGrid4: 

For Auto Grid following the below steps:(preparing gpf file)  

1. Grid >Macromolecule> Choose> Click (Protein) > Select Molecule > 

OK > save as PDBQT 

2. Grid> Set Map types >Choose Ligand> Click (Ligand) > Select Ligand 

3. Grid>GridBox> Set the BOX> File>Close Saving Current  

4. Grid> Output > Save  GPF> grid.gpf> save 

**************************************************************** 

After having   finished above steps following the below ways: 

For Autodock  following  the below steps:(preparing  dpf file)  

1. Docking>Macromolecule>Set Rigid filename>Select  Protein.pdbqt‟ 

>Open 

2. Docking>Ligand>Choose>Click Ligand‟ >Select Ligand>Accept  

3. Docking>SearchParameters>GeneticAlgorithm>Accept 

4. Docking>Output>Lamarckian GA> Save file as dock.dpf‟ 

*************************************************************** 

Now copy the autogrid4.exe, autodock4.exeandAD4.1_bound.datfile 

sinto the destination folder (working folder) and check whether 2 pdbqt files 

and grid.gpf and dock. dpf files are there. 
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After having  finished above steps following the below ways:  

1. Open cmd (command prompt). Windows +R and type cmd enter  

2. In command prompt go the destination folder by cd commands.  

3. Run the following  commands 

4. Autogrid4.exe -p grid.gpf -l grid.glg (wait for the response) 

5. Autodock4.exe-pdock.dpf-ldock.dlg(wait for the response) 

Now the dock.dlg file is your docking  result.  

1. Analyze >Docking>Open> Select „dock.dlg‟> Open >Assign Ligand 

New Name> OK 

2. Analyze > Macromolecule > Choose> Click Protein > Select 

Macromolecule 

3. Analyze> Conformations> Play, Ranked By Energy or Play > Click on 

the „&‟Button 

4. Set Play Options >Check „Build H-Bonds‟> View the hydrogen bonds 

formed> Check „Show Info‟> View the Interaction Energy > Build 

Current Write Complex>Save as Result.pdb save …  

For better ligand interactions you can open the result.pdb in Molegro 

Molecular Viewer and View it and save the ligand interaction image.  
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CHAPTER – 7 

RESULTS AND DISCUSSION 

 

7.1. PERCENTAGE  YIELD  EXTRACTS  OF  OXYSTELMA 

ESCULENTUM R.BR. 

Table-3: Percentage yield and appearance of extract of Oxystelma 

esculentum  R.BR. 

EXTRACTS APPEARANCE PERCENTAGE YEILD  (W/W) 

HEXANE GREEN 11.2% 

CHLOROFORM DARK GREEN 9.2% 

ETHYL 

ACETATE 

YELLOWISH 

GREEN 
7.3% 

ETHANOL REDDISH BROWN 12.5% 

The appearance of concentrated and dried extracts of hexane,  

chloroform, ethyl acetate and ethanol were observed and percentage yield was 

calculated for the extracts described in the table 3. 

7.2  PHYTOCHEMICAL  SCREENING  OF  EXTRACTS 

From the preliminary phytochemical screening, it was found that all the 

extracts on the aerial parts of Oxystelma esculentum R.BR.showed the presence 

of different primary and secondary metabolites.  The observation was listed 

below. 
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Table-4: Phytochemical screening on aerial parts of oxystelma esculentum R.BR. 

COMPOUNDS 
HEXANE 

EXTRACT 

CHLOROFORM 

EXTRACT 

ETHYL 

ACETATE 

EXTRACT 

ETHANOL 

EXTRACT 

Alkaloids -VE +VE +VE +VE 

Reducign sugar -VE +VE +VE +VE 

Saponins +VE +VE -VE -VE 

Phytosterols -VE +VE +VE +VE 

Tannins -VE +VE -VE +VE 

Flavonoids -VE +VE +VE +VE 

Protein and 

Aminoacid 
-VE -VE -VE +VE 

Terponoids +VE +VE +VE +VE 

Glycosides -VE +VE +VE +VE 

Fixed oils and 

fats 
+VE +VE -VE -VE 

NOTE:  +VE  INDICAT E   THE  PRESENCE  OF  PHYTOCONSTITUENT 

  -VE  INDICATE    THE   ABSENCE  OF  PHYTOCONSTITUENT 

RESULT 

As illustrated in table 4 hexane extract shows the presence of terpenoids,  

saponins and oils and fats. Chloroform extract shows the presence of alkaloids, 

carbohydrate, phytosterols, tannins, glycosides and oil and fats. Ethyl acetate 

extract shows the presence of alkaloids, carbohydrates, saponins, phytosterols, 

phenols, terpenoids, glycosides and flavanoids. Ethanolic extract shows the 

presence of glycosides, flavonoids, phytosterol, alkaloids, terpenoids and 

phenolic compounds. 

DISCUSSION 

The above phytochemical investigation has  revealed that the ethanolic 

extract  on the aerial parts of Oxystelma esculentum R.BR.have various 

phytochemical constituents compared to other extracts like glycosides, 
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flavanoids, phytosterol, alkaloids, terpenoids and phenolic compounds. These 

active constituents possesses numerous pharmacological activities like anti 

microbial,anti inflammatory,stress related disorders and  as diuretics. 

7.3 INVITRO ANTI-ALZHEIMER ACTIVITY OF EXTRACTS 

Table 5. Effect of extracts of Oxystelma esculentum R.BR on 

acetylcholinesterase inhibition 

 

Conc. 

(µg) 

Standard 

(Galantamine) 

Hexane 

(HEX) 

Chloroform 

(CH) 

Eethyl 

Acetate (EA) 

Ethanol 

(E) 

25 0.844868 0.158457 0.374019 0.261059 0.261059 

50 1.395604 0.333459 0.261059 0.374019 0.414937 

100 0.311203 0.274455 0.374019 0.374019 0.364303 

200 0.158456 0.215940 0.374019 0.364303 0.364303 

400 0.392732 0.274455 0.261059 0.059940 0.316913 

800 0.364303 0.215940 0.261059 0.844868 0.571324 

IC50 

Value 
14.22 726.07 171.41 72.01 38.54 

 

Fig-13: Graph representing acetylcholinesterase inhibition assay of 

Oxystelma esculentum R.BR. 
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 STD 

 HEXANE 

ETHYL ACETATE 

CHLOROFORM 

ETHANOL 

Fig:14  In vitro acetylcholinesterase assay showing different concentration of 

dilution of Oxystelma esculentum R.BR. 
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RESULTS 

As illustrated in the above table 5, all the extracts were subjected to 

acetylcholinesterase inhibition assay. It was observed that ethanol extract has 

good acetylcholinesterase inhibition compared with other extracts with an IC 50 

value of 38.54. The Galantamine was used as a standard, and its IC50 values 

was found to be 14.22. The percentage inhibition of acetylcholinesterase for the 

extracts was described in Figure 13. 

DISCUSSION 

From the above results, it was determined that,ethanol extract of 

Oxystelma esculentum R.BR has good in vitro anti-alzheimer activity by 

inhibiting acetylcholinesterase enzyme with an IC50 value 38.54  respectively. 

The acetylcholinesterase enzyme begins the breakdown of the 

neurotransmitter acetylcholine into choline and acetate which causes deficiency 

of acetylcholine in postsynaptic neuron of brain leads to memory deficits.  The 

acetylcholinesterase enzyme (AChE) is an attractive target for the discovery of 

mechanism-based inhibitors because of its role in hydrolysis of the 

neurotransmitter acetylcholine. AChE inhibitors as rivastigmine, donepezil, or 

galantamine are currently the most effective agents to treat cognitive symptoms 

of AD and have other possible therapeutic applications in the treatment of other 

neurodegenerative disorders
. [62,63] 

Recently, research on prevention and treatment of Alzheimer has 

focused on naturally occurring acetylcholinesterase (AChE) inhibitors from 

plants, namely, polyphenolic compounds such as flavonoids with inhibitory 

capacity similar to that of the currently prescribed AChE inhibitor drugs.  

Hence based on the above evidence, we have carried out in vitro 

screening of extracts of O esculentum against acetylcholinesterase target 

enzyme. It was observed that ethanol extract shows promising inhibition 

against the enzyme compared with other extracts. Furthermore ethanol extract 

was considered as an active extract and subjected for in vivo anti Alzheimer 

activity and for the isolation of compounds by column chromatography 
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7.4   ACUTE  TOXICITY  STUDY  OF  ETHANOL  EXTRACT  OF  

OXYSTELMA ESCULENTUM R.BR IN MICE. 

Table 6. Results of acute toxicity in mice on administration of ethanol 

extract of Oxystelma esculentum R.BR at the dose of 2000mg/kg 

 

OBSERVATION 30 MINS 4 HOURS 24 HOURS 14
th 

DAY 

BODY WEIGHT - - - - 

PRETERMNAL DEATH - - - - 

CONVULSIONS - - - - 

RIGHTING REFLEX + + + + 

LACRIMATION - - - - 

SALIVATION - - - - 

RESPIRATION + + + + 

DIARRHOEA - - - - 

SEDATION - - - - 

EXCITATION + + - + 

AGGRESSION + + + + 

NOTE   + INDICATES  PRESENCE  AND  -  INDICATES ABSENCE. 

RESULT 

As described in table 6, the ethanol extract was found to be non-toxic 

and safe upto the dose of 2000mg/kg body weight. The behavioural changes 

and mortality were not observed for tested mice. Hence, LD50 value is expected 

to increase the dose level above 2000mg/kg body weight.  From this 

2000mg/kg,1/10
th 

(200mg/kg) and 1/5
th 

(400mg/kg) were selected as Low dose 

and High dose treatment for in vivo studies. 
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7.5. IN VIVO ANTI-ALZHEIMER ACTIVITY OF ETHANOL EXTRACT 

ON SCOPOLAMINE INDUCED AMNESIA IN MICE 

Y MAZE METHOD 

 

Fig:15. Y Maze method 

Table 7. Percentange alterations of different group of drug treated mice by  

Y Maze method 

GROUP 
PERCENTAGE 

ALTERATIONS 

CONTROL 60.33± 2.50 

SCOPOLAMINE 16.54± 1.50
***

 

SCOPOLAMINE+200mg/kg of O.esculentum 65.45 ±6.55
*** 

SCOPOLAMINE+400mg/kg of O.esculentum 76.50 ±5.45
*** 

STD – DONEPEZIL 72.34± 4.56
*** 

Values are expressed as Mean± SEM (n=6). The percentage alteration 

significantly decreased for the scopolamine group (
***

p< 0.001 vs control). The 

administration of O.esculentum at 200mg/kg and 400 mg/kg increases the 
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percentage alterations (
***

p <0.001) vs scopolamine . One way Anova followed 

by Dunnets t test. 

RESULT 

The results obtained for the effect of O.esculentum on percentage of 

spontaneous alterations in Y maze are depicted in table 7. The control group 

was compared with scopolamine induced group and observed that the reduction 

was significant.After the treatment, both low dose 200mg/kg and high dose 

400mg/kg and standard Donepezil treated group shows a significant 

improvement (p <0.001) in memory and learning ability. 

OPEN FEILD METHOD 

 

Fig 16. Open feild test in mice. 

Table 8.  Number of crossing, rearing and time spent in centre
 

Parameter Control 
Scopolamine 

Disease 

Low dose 

of ethanol 

extract 

High dose 

of ethanol 

extract 

Standard 

Donepezil 

Number of 

crossing 
75±2.8 45±3.1

*** 
60±3.4

*** 
71±4.7

*** 
75±1.8

*** 

Number of 

rearing 
9±1.9 5±0.8

*** 
6±1.5 8±1.1

 
10±1.1

** 

Time spent 

in minutes 
4±1.1 2.5±0..8

*** 
3±1.0 

4.5±0.8** 

 
5±2.0

*** 

Each value represents the Mean±SEM (n=6).The number of crossing, 

rearing and time spent in the open feild decreases for the scopolamine group 
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(
***

p<0.001 vs control) and the administration of O.esculentum extract at 

200mg/kg and 400mg/kg body weight increases this number of crossing and 

rearing (
**

p<0.01 and 
***

p<0.001 vs scopolamine). One way ANOVA followed 

by Dunnets t-test. 

RESULT 

The treatment of ethanolic extract of O.esculentum (200mg/kg and 

400mg/kg) exhibited a significant (
**

p<0.01; 
***

p<0.001) effect respectively on 

the number of crossings and number of rearings of open feild acquisition of 

memory compared to the negative control group(scopolamine group).  

The results obtained indicated that the high dose of 400mg/kg of 

O.esculentum exhibited better exploratory behaviour in number of crossing 

table 8.The effect of ethanolic extract of O.esculentum on line crossing 

indicated that the administration of 200 mg/kg and 400mg/kg exhibited 

significant difference of p<0.01 and p`,0.001.In rearing the result obtained 

indicated that the animal treated with 400mg/kg exhibit a significant p<0.001 

compared to disease induced group. 

TRACTION TEST 

Table 9. Retention time of mice by Traction test 

GROUP 
RETENTION TIME IN 

SECONDS 

CONTROL 14.00± 1.10 

SCOPOLAMINE 4.50± 1.50
**

 

SCOPOLAMINE+200mg/kg of 

O.esculentum 
9.5 ±2.55

* 

SCOPOLAMINE+400mg/kg of 

O.esculentum 
28.57 ±2.00

*** 

STD – DONEPEZIL 26.34± 4.56
*** 

**
p<0.01 Negative control- Scoolamine induced at 400mg/kg 

***
p<0.001.Oneway anova followed by dunnets t test  
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RESULT 

In the traction test, the Scopolamine induced group exhibited loss of 

muscle contraction, which is considered as a sign of neurotoxcity in general. 

The animals in the negative control (p<0.01) showed a significant reduction in 

retention time and downfall in ashort duration of time when compared to 

normal control group. The administration of O.esculentum has shown a 

significant effect on enhancing motor co ordination and balancing ability in 

mice.The animals after treatment with O.esculentum with 400mg/kg exhibited 

significant (p<0.001) spending more time balancing compared to scopolamine 

induced group. 

DISCUSSION 

The present study was undertaken to investigate whether Oxystelma 

esculentum could improve memory impairment in mice. Medicinal plants are 

playing a significant role in the management of memory deficit and Alzheimer’s 

disease. Scopolamine promoted amnesia in the animals through impaired 

memory by blocking the muscarinic cholinergic receptors in the brain as earlier 

reported. 

In neuroprotective evaluation, behavioral studies with Y-maze and open-

field habituation memory exhibited promising results on cognitive 

improvement after scopolamine-induced amnesia. In the Y-maze test, the 

number of entries in each arm was observed and recorded. There was a 

significant improvement, which indicates that there is a significant effect 

produced by the ethanol extract of O. esculentum on treating memory and 

learning impairment
. 

The open-field test was conducted followed by the Y-maze test. The 

purpose of this test was to measure the exploratory behavior of the mice in a 

new environment, anxiety level, and the level of cognition. In the open-field 

test, the study showed that the administration of scopolamine exhibited a 

significant effect on declining the memory and learning level in the mice and it 

was clearly observable in the line crossing test, rearing, and number of head 

dipping test
.[61]

 Open-field exploration and habituation memory are considered 
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to be disturbed in age-related disease  in animal models and studies suggest that 

phytoconstituents rich in polyphenols and flavonoids and terpenoids tend to 

improve AD 

In our study, it is evident from the open-field test that the treatment with 

ethanolic extract of O.esculentum enhanced cognitive performance. In the 

traction test, the time taken for the mice to retain on the retort bar was recorded 

and this test was carried out to examine the changes in sensorimotor 

performance during aging. In this test, it was indicated that only the high dose 

group (ethanolic extract of O.esculentum 400 mg/kg) produced a significant 

effect toward amnesic mice, whereas the low dose group had no significant 

activity toward the amnesia induced by scopolamine, but an increase in the 

mean was observed in this group compared to the negative control group. This 

shows that ethanolic extract of O.esculentum is involved in neuroprotection and 

improves the sensorimotor performance in aging. 

Administration of scopolamine for a prolonged period of time causes 

amnesia and this induction model is associated with Alzheimer’s model. 

Scopolamine is a nonselective muscarinic acetylcholine receptor which has the 

tendency to reduce the induction of long-term potentiation in the brain which 

relates to the decrease in memory and learning ability 

BIOCHEMICAL ESTIMATION 

Table-10. The biochemical estimation of Malondialdehyde, Glutathione, 

Catalase in homogenised mice brain 

Group Group Name 
MDA 

(mmol/g) 

Glutathione 

(mmol/g) 

Catalase 

(mmol/g) 

A Control 59.30±3.54 5.56±0.36 287.56±10.34 

B 
Disease Control 

(Scopolamie) 

97.32±3.14**
 

 
1.57±0.10

** 
107.32±4.65

*** 

C 

Ethanol Extract 

(200mg/kg) + 

Scopolamine  

70.87±3.87
* 

3.72±0.16
* 

250.44±8.78
** 



Results and Discussion 

Department of Pharmaceutical Chemistry, COP, MMC. Page 55 

Group Group Name 
MDA 

(mmol/g) 

Glutathione 

(mmol/g) 

Catalase 

(mmol/g) 

D 

Ethanol Extract 

(400mg/kg) + 

Scopolamine  

64.8±4.47
*** 

4.36±0.09
** 

315.72±18.89*** 

E 
Standard 

Donepezil 
59.3±6.89

*** 
4.98±0.12

** 
387.60±10.14

*** 

Each value represents the mean SEM (n=6). The level of MDA increases 

and the antioxidant level decreases for the scopolamine group ( **p<0.01, 

***p<0.001) vs control and the administration of O.esculentum extract 

decrease the level of MDA by increasing the level of antioxidant enzymes ( 

*p<0.05, **p<0.01, ***p<0.001) vs scopolamine.Oneway  ANOVA followed 

by Dunnets t test. 

RESULT 

The administration of scopolamine induces oxidative damage in 

animals.The MDA levels increases significantly p<0.001 in the mice of group 

receiving only scopolamine of 97.32 3.14 compared to the control which has a 

level of 59.30 3.54.The level of MDA significantly decreases in the group of 

animals that received the treatments with the dose of O.esculentum ethanol 

extract. 

Scopolamine significantly decrease the glutathione level to 1.57 1.0 

p<0.01.Treatment with 400mg/kg of ethanol extract of O.esculentum 

significantly increases the glutathione level of 4.98 0.12 p<0.01 

Scopolamine also significantly decrease the level of catalase to 107.32 

4.65 p<0.001 compared to control. Administration of 400mg/kg of ethanol 

extract of O.esculentum significantly increase the level of 315.72 18.89 

Catalase and Glutathione increased significantly with administration of 

Donepezil p<0.001.The results are shown in the table 10.  
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DISCUSSION 

Scopolamine induced memory disorders are associated with increased 

oxidative stress in the brain characterized by an increased Malondialdehyde 

levels which is harmful effect of reactive oxygen species.  The results of these 

present study showed a collapse in brain antioxidant defence mechanism 

characterized by a higher MDA level and lower catalase, Glutathione levels, 

while the level of MDA decreases significantiy.Finally the ethanol extracts of 

O.esculentum possesse anti-oxidant potentials by increasing the catalase, 

Glutathione, and decreasing MDA levels significantly in memory impaired 

mice. Thus inhibition of reactive oxygen takes place by ethanol extract of 

plant.
 

7.6 ISOLATION  OF  ETHANOL  EXTRACT   BY  COLUMN          

CHROMATOGRAPHY 

Table 11.  Total number of fractions collected and their solvent systems 

S.No Fractions Solvent system & ratios 

1 F-1 Hexane (100%) 

2 F-2 to F-

38 

Hexane:Ethyl acetate 

(95:5,90:10,85:15,80:20,75:25,70:30,65:35, 

60:40,55:45,50:50,45:55,40:60,35:65,30:70,25:75, 

20:80,15;85,10:90,5:95 

3 F-39 Ethyl acetate (100%) 

4 F-40 to 

F-78 

Ethyl acetate:Chloroform(97:3,94:6,91:9,88:12, 

85:15,82:18,79:21,76:24,73:27,70;30,67:33, 

64:36,61:39,58:42,55:45,52:48,49:51,46:54, 

43:57,40:60,37:63,34:66,31:69,28:72,25:75, 

22:78,19:81,15:85,10:90 

5 F-79 Chloroform(100%) 

6 F-80 to 

F-113 

Chloroform:Methanol(98:2,96:4,94:6,92:8, 

90:10,88:12,86:14,84:16,82:18,80:20,78:22, 

76:24,74:26,72:28,70:30,68:32,66:34,64:36, 

62:38,60:40,58:42,56:44,54:46,52:48,50:50, 

45:55,40:60,35:65,30:70,25:75,20:80,15:85,10:90 

 

  



Results and Discussion 

Department of Pharmaceutical Chemistry, COP, MMC. Page 57 

Table 12.  Rf  value for isolated compound 

Isolated  

Compound 
TLC Solvent System No. of SPOT Rf  Value 

V 1 

Chloroform:methanol (8:2) 1 0.84 

Chloroform:methanol (8:2) 1 0.85 

Chloroform:methanol (7:3) 1 0.90 

 

Fig17.   Separation of compounds by column 

RESULT 

The ethanol extract was eluted with various solvents by gradient elution 

method. Each fraction was collected as 100 ml. The ftraction were analysed by 

Thin Layer Chromatograohy for determination of Rf value. The yellow colour 

band was eluted and collected from the fraction number 85 – 88 in solvent 

composition Chloroform:Methanol (94:6, 91:9, 88:12, 85:15). The collected 

yellow fractions showed single spot in TLC, UV (254nm,366nm), and in Iodine 

vapour with the same Rf value in various solvent composition of chloroform 

and methanol. Hence the fractions were mixed together and evaporated to get a 



Results and Discussion 

Department of Pharmaceutical Chemistry, COP, MMC. Page 58 

crystals. The isolated compound designated as V1. The obtained yellow 

crystals were then subjected for characterization in UV, IR, and 1H-NMR and 

LC-MS
 

7.7  CHARACTERIZATION OF ISOLATED COMPOUNDS 

RESULTS AND DISCUSSION 

The compound V1  is a yellow crystal compound. 

The melting point of this compound was found to be 67
ο
C 

The UV was performed in (ethyl acetate) λ max was found to be 230nm 

FT-IR in (cm
-1

) 

3334 cm
-1

 Aromatic OH groups bonded to cyclopentane pyran system. 

3030 cm
-1

 Aromatic C-H stretch 

1218 cm
-1

 pure stretching vibration of cyclopentane pyran system
 

Mass m/z:  625.48 [M+1]
+
; 

1
H-NMR (CDCl3): 5.32 (1H, s, =CH), 3.89 – 3.95 (10H, m, -CH); 3.82 – 

3.85 (4H, m, -CH); 3.63 – 3.65 (4H, d, -CH); 3.42 – 3.44 (4H, m, -CH); 2.11 – 

2.14 (4H, m, -CH);1.78 (1H, m , -CH); 1.28 – 1.33 (6H, m, -CH2); 1.22 – 1.25 

(4H, m, -CH2);  1.21 (6H, d, -CH3). 

From the characterization reports of above compound and from the 

library database which was obtained from QTOF HRLCMS. The isolated 

compound was found to be KANOKOSIDE D (an iridoid glycoside) – Terpene 

Glycoside. 
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Fig 18. UV SPECTRUM OF ISOLATED COMPOUND V1 

 

 

Fig  19. FT-IR SPECTRUM OF ISOLATED COMPOUND V1 
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Fig 20. HR LCMS OF ISOLATED COMPOUND V1 

 

Fig 21  MASS SPECTRUM OF ISOLATED COMPOUND V1 
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Fig 22. PROTON NMR OF ISOLATED COMPOUND V1 
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7.8  IN VITRO ANTI-ALZHEIMER ACTIVITY OF KANOKOSIDE-D BY 

ACETYLCHOLINESTERASE INHIBITION ASSAY 

 

 

Fig23. Different concentrations of dilution of Kanokoside D by 

acetylcholinesterase inhibition assay 

 

Table 13. Percentage inhibition of Kanokoside D on acetylcholinesterase 

inhibition assay 

Concentration 

(in µg level) 

STD 

(DONEPEZIL) 
KANOKOSIDE D 

50 36.96 30.56 

100 53.97 43.02 

200 68.13 49.72 

400 83.79 61.53 

800 90.09 77.63 

IC50 85.89 135.54 
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Fig 24.  Graph representing acetylcholinesterase inhibition assay of 

Kanokoside D 

RESULT 

As depicted in the table 12. the isolated Kanokoside a terpene glycoside 

(Iridoid) was investigated for acetylcholinesterase inhibitor. It was observed 

that Kanokoside D had good acetylcholinesterase inhibitor with an IC 50 value 

of 135.54 compared with the standard Donepezil has greater inhibitor of 85.89. 

DISCUSSION 

Kanokoside D is an Iridoid glycoside. Iridoids are a class of 

monoterpenoid compounds constructed from 10-carbon skeleton of isoprene 

building units. These compounds in their aglycones and glycosylated forms 

exist in nature to contribute to mechanisms related to plant defenses and 

diverse plant-animal interactions
.[60] 

 
Therapeutic Potential for Alzheimer’s Disease  

0

20

40

60

80

100

0 200 400 600 800 1000

%
 in

h
ib

it
io

n
 

Concentration (µg/ml) 

Acetylcholinesterase assay 

Donepezil

compound



Results and Discussion 

Department of Pharmaceutical Chemistry, COP, MMC. Page 64 

The vast arrays of neuroprotective effects of iridoids and some 

monoterpenes have been investigated. The β-amyloid peptide (Aβ) formation, 

aggregation and function have been the major target areas of AD for in vitro 

experiments. In a study by the β-secretase (recombinant human BACE1) 

inhibitory activities of some monoterpenes have been evaluated.  

Insights into the Mechanism of Action of Iridoids and Other 

Monoterpenes in AD 

The role of Aβ in the pathology and as therapeutic target for AD has 

been reviewed in the various literatures Recent review articles from our 

laboratories have also shown that many polyphenolic compounds such the 

flavonoids, diterpenoids and cinamate derivatives display therapeutic potential 

for AD through multiple mechanisms involving Aβ.  Hence, the formation, 

aggregation and toxicity of Aβ can all serve as targets for therapeutic agents.  

The predominant forms of the pathological Aβ in the brain are Aβ1–40 

and to a lesser extent Aβ1–42 which are formed through the amyloidgenic β-

secretase-dependent pathway. The selective inhibition of this enzyme by 

monoterpenes without much effect on the non-amyloidogenic marker enzyme 

(α-secretase) is an interesting finding. A large body of evidence also suggests 

that monoterpenes ameliorate the Aβ-induced cytotoxicity both in cultured 

neuronal cells and various animal models of AD. 

 

Fig 25: Targets of  iridoid glycosides 
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Therapeutic targets of iridoids and other monoterpenes discussed in this 

review. Antiinflammatory effect, amelioration of oxidative stress, mechanisms 

related to Aβ formation, aggregation and clearance, τ-protein phosphorylation 

and aggregation, and neurotoxicity associated with mitochondrial dependent 

and independent mechanisms are among the therapeutic targets. 

7.9 IN SILICO MOLECULAR PROPERTY  PREDICTION OF 

KANOKOSIDE D 

The molecular properties of Kanokoside D were calculated by using 

Molinspiration and Chemoinformatics and data
,
s given below. From the data, it 

rvealed that the Kanokoside D obeys the Lipinski
,
s rule of  5 (with some 

violations).Hence the compound has drug-likeness property and it can be a 

potential drug candidate. 

Lipinski
’
s rule of five 

Molecular weight <500 Da 

ClogP < 5 

Number of hydrogen bond donors < 5 

Number of hydrogen bond acceptors < 10 

Number of rotatable bonds < 7 

Polar surface area < 140 A
2 

 

Fig 26. Insilico predicted molecular properties of Kanokoside D 
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RESULTS AND DISCUSSION 

The physicochemical properties of the Kanokoside D possessing 

molecular weight 624.63 dalton, total polar surface area 254.53 and hydrogen 

bond donor 9 which slightly violating the Lipinski`s rule of five.  

7.10 MOLECULAR DOCKING STUDY OF KANOKOSIDE D AGAINST 

ALZHEIMER  TARGET  PROTEIN 

o Acetylcholinesterase 

o β-Secretase 

DOCKING OF STANDARD RIVASTIGMINE WITH HUMAN 

ACETYLCHOLINESTERASE ENZYME 

 
Fig 27.  Docking of rivastigmine in target protein of acetylcholinesterase.  

 

Fig 28. Molecular interaction between Rivastigmine with acetylcholinesterase  
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DOCKING OF KANOKOSIDE D WITH HUMAN 

ACETYLCHOLINESTERASE 

 

Fig29.  Docking of Kanokoside D with Hman acetylcholinesterase  

 

Fig 30. Molecular interaction between Knokoside D and acetylcholinesterase  

Table 14. Docking scores of  Rivastigmine and Kannokoside D 

Protein Ligand 
Predicted Binding 

Energy (kcal/mol) 

Human Acetylcholinesterase 

PDB ID:1GQR 

Rivastigmine -5.82 

Kanokoside D -4.38 

RESULT AND DISCUSSION 

The molecular docking study of Kanokoside D against Alzheimer target 

protein investigated in fig 29. The ligand (Kanokoside D) form hydrogen bond 
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interactions with amino acid  Asparagine 230, luecine 305 and Glutamic acid 

306 was observed in the fig 30. The predicted binding energy of Kanokoside D 

against acetylcholinesterase was found to be -4.38 kcal/mol compared with the 

standard binding energy of -5.82 kcal/mol. 

DOCKING OF STANDARD RIVASTIGMINE WITH Β-SERETASE 

ENZYME 

 

Fig 31. Docking of Rivastigmine with β-Secretase enzyme 

 

Fig 32. Molecular interaction between rivastigmine and β-secretase 
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DOCKING OF KANOKOSIDE WITH Β-SECRETASE ENZYME 

 

Fig 33. Docking of Kanokoside D with β-secretase 

 

Fig34 Molecular interaction between Kanokoside D and β-secretase 
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Table 15. Docking score of  Rivastigmine and Kannocoside 

Protein Ligand Predicted Binding Energy (k cal/mol) 

β –Secretase 

PDB ID:1 SGZ 

Rivastigmine -4.67 

Kanokoside D -6.82 

RESULT 

The molecular docking study of Kanokoside D against β-secretase.The 

ligand form hydrogen bond interactions with amino acid  Alanine 157, valine 

361, histidine 360, cysteine 359 and valine 170 was observed in the docking 

study Fig 32 .The predicted binding energy was found to be -6.82k cal/mol 

compared with the standard rivastigmine -4.67 k cal/mol 

It is clearly indicates that Kanokoside D show potential role in AD 

and active against β-secretase enzyme. The selective inhibition of this 

enzyme play an important role in AD. It was also proved in our present 

research findigs of in vitro acetylcholinesterase inhibition assay of Kanokoside 

D with IC50 value of 135 compared with Donepezil 85. 

DISCUSSION 

In this docking study we present an approach to control alzheimer 

disease by targeting the enzymes Human acetylcholinesterase and β-secretase 

enzyme with standard drug Rivastigmine  and Kanokoside D an isolated 

compound from Oxystelma esculentum R.BR. Acetylcholinesterase responsible 

for breakdown of transmitter substance acetlcholine, β-secretase enzyme 

responsible for the formation of beta-amyloid plaques in brain leads to the 

disease. Hence for inhibition we are targeting this enzymes.  

The ligand (Kanokoside D) was found to have a better binding energy of 

-4.38, -6.82 kcal/mol as compared to standard drug Rivastigmine  -5.82, -4.67 

kcal/mol. Hence an isolated compound has better binding energy into 

acetlcholinesterase and β-secretase enzyme. 
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CHAPTER-8 

SUMMARY AND CONCLUSION 

 

Oxystelma esculentum R.BR.aerial parts was selected for the present 

research work to investigate the anti-alzheimer activity. First the aerial parts of 

O.esculentum was sequentially extracted by hot continous percolation method 

by using solvents such as Hexane, Chloroform, Ethyl acetate and Ethanol. All 

the extracts were screened for preliminary phytochemical screening to 

determine the secondary metabolites present in the extract. It was observed that 

the ethanol extract possess maximam phytoconstituents compared to other 

extracts, containing glycosides, flavonoids, terpenoids, alkaloids, phytosterol 

and phenolic compounds. These active constituents possess numerous 

pharmacological activities. 

Invitro acetylcholinesterase inhibition assay 

All the extracts were investigated for in vitro acetylcholinesterase 

inhibition assay. It was observed that ethanol extract exhibits good 

acetylcholinesterase inhibition compared with other extracts with an IC 50 value 

of 38.54. The polyphenolic compounds such as flavonoids, terpenoids, 

glycosides have inhibitory capacity against acetylcholinesterase similar to that 

of currently prescribed synthetic drugs. Hence ethanol extract was considered 

as an active extract and subjected for in vivo anti-alzheimer activity and for 

isolation of compounds by column chromatography.  

Acute toxicity study 

The ethanol extract was found to be non toxic and safe upto the dose of 

2000mg/kg body weight. The LD50 value is expected to increase the dose level 

above 2000mg/kg. From this 1/10 
th

(200mg/kg) and 1/5
th

(400mg/kg) was 

selected for in vivo studies 

In vivo anti Alzheimer activity of ethanol extract of O.esculentum 
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In vivo anti Alzheimer activity was investigated by evaluating the 

ethanol extract against Y Maze, Open feild and Traction test method.The 

treatment of 200mg/kg and 400mg/kg of ethanol extract of O.esculentum 

showed a significant increase in (p<0.001) spantaneous alterations and improve 

the memory and learning ability in mice.  

In open feild method, ethanol extract of O.esculentum at 200mg/kg and 

400mg/kg exhibited a significant increasing effect on number of crossings and 

number of rearings compared to scopolamine group. The high dose of 

400mg/kg of extract exhibited a better exploratory behaviour in mice in number 

of crossings. 

In traction, the administration of O.esculentum has shown a significant 

effect on enhancing the motor co-ordination and balancing ability in mice. At 

400mg/kg of ethanol extract of O.esculentum exhibits significant (p<0.001) 

spending more time balancing ability compared to scopolamine induced group.  

Biochemical estimation 

The administration of scopolamine induces oxidative damage in animals 

MDA level increases significantly in the mice of group rearing scopolamine.  

The level of MDA significantly decrease in the group of animal that 

received the treatments with the dose of ethanol extract of O.esculentum. 

Treatment of 400mg/kg of ethanol extract of O.esculentum significantly 

increase the glutathione level p<0.001  

Administration of 400mg/kg of ethanol extract significantly increase the 

level of catalase. 

Isolation of compound from active extract by Column chromatography 

The ethanol extract shows promising effect in both in vitro and in vivo 

anti Alzheimer activity. Hence ethanol extract was subjected to column 

chromatography isolation.The ethanol extract was eluted with various solvents 

by gradient elution technique. The yellow colour band was eluted and collected 
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from the fraction 85-88 in the solvent composition chloroform:methanol. The 

collected yellow fractions showed a single spot in TLC, UV (254nm,366nm), 

and in iodine vapour. Hence the fractions were mixed together and designated 

as V1. 

The isolated compounds was characterized by UV, FT-IR, 
1
H-NMR and 

LC-MS. From the characterization report the isolated compound was 

determined as Kanokoside D, which is a Iridoid glycoside.  

Acetylcholinesterase inhibition of Kanokoside D 

The isolated Kanokoside D was investigated for acetlcholinesterase 

inhibition assay. It was observed that Kanokoside D has good AchE inhibition 

with an IC50 value of 135.54 compared with the standard Donepezil has a 

greater inhibition of 85.89. 

In silico molecular property and docking study of Kanokoside D 

The molecular properties of Kanokoside D were calculated by using In 

silico Molinspiration Cheminformatics tool showed that the Kanokoside D 

compound slightly violating the Lipinski
’
s rule of 5 (3 violations). The 

compound Kanokoside D was docked with two targets Human 

acetylcholinesterase and β-secretase. The ligand (Kanokoside D) showed a 

better binding energy -4.38 with that of standard Rivastigmine having -5.82 

with the target acetylcholinesterase. The ligand form hydrogen bond interaction 

with Asparagine 230, leucine 305 and glutamic acid 306. 

The molecular docking study of Kanokoside D against β-secretase shows 

a better binding energy of 6.82 k cal than the standard Rivastigmine having -

4.67 k cal. The ligand showing hydrogen bond interactions with Alanine 157, 

Valine 361, histidine 360, cysteine 359 and valine 170. 

It clearly indicates that Kanokoside D shows potential role in AD.  

  



Summary and Conclusion 

Department of Pharmaceutical Chemistry, COP, MMC. Page 74 

CONCLUSION 

Ethanolic extract of O.esculentum shows promising role in anti-

alzheimer activity by evaluating against scopolamine induced amnesia. The 

phytochemical constituents in the ethanol extract may be responsible for the 

decrease in neurotoxcity in mice.The Kanokoside D an iridoid glycoside, first 

isolated from the plant and have a role in inhibition of neurotoxcity and 

improvement of memory in mice. 
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CHAPTER-9 

FUTURE PROSPECTUS 

 In future study Kanokoside D will be evaluated for in vivo anti -

alzheimer study in mice. 

 Iridoid glycosides (Kanokoside D) a potential inhibitory effect in 

numerous cancer.  So in future the in vitro cell line in cancer also 

studied. 

 The Kanokoside D will be evaluated in future for effective drug delivery 

system. 
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